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Preface

This guide includes instructions for installing and upgrading to Kofax TotalAgility Integration Server
7.11.0, and integrating it with other products.

Read this guide completely before installing the software.

TotalAgility documentation

To access the full documentation set online, see the Kofax TotalAgility Documentation page.

To launch the online help for the installed version of the product, click the Help icon in the
application.

© when upgrading to TotalAgility 7.11.0 from an earlier version, ensure that the check box for

"Import system Workspace package" is selected to view the Workspace help online; otherwise,
you must import the WorkspaceHeader form from the TotalAgility Workspace package.

You can access the Kofax TotalAgility documentation online as well as offline mode.

Full documentation set

A complete set of TotalAgility documentation includes the following items.

Guide/Help Description

Administrator's Guide Provides information for administrators who are responsible
for configuring and maintaining a TotalAgility installation.

API Documentation Includes the details of the supported APIs excluding deprecated
methods, a list of supported methods for each service, and all
inputs and outputs including the required fields, field types,
and enumerations, any special information about the method,
some coding examples, and the details behind concepts used.

Architecture Guide Provides an overview of the TotalAgility architecture, covering
various deployments for on-premise, on-premise multi-tenancy,
and Azure environments.

Best Practices Guide Describes the best practices to follow when using TotalAgility
to improve performance, cost, maintenance, availability, and
security.
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Guide/Help

Description

Configuration Utility Guide

Provides instructions for using the Configuration Utility to
update settings across various configuration files for different
installation and deployment types.

Designer Help

Provides details about using TotalAgility to design business
jobs and cases, assign resources, create forms, integrate with
external applications, and more.

Features Guide

Provides an overview of the TotalAgility features.

Installation Guide

Provides instructions on installing TotalAgility and integrating it
with other products.

Integration Server Installation Guide

Provides instructions on installing TotalAgility Integration
Server and integrating it with other products.

On-Premise Multi-Tenant Installation
Guide

Provides instructions on installing and configuring a TotalAgility
On-Premise Multi-Tenant system.

Prerequisites Guide

Provides system requirements for installing TotalAgility,
instructions for running the Pre-requisite Utility, and a software
checklist for various installation types.

Release Notes

Include key details about the new and enhanced features and
any changes in behavior in TotalAgility 7.11.0. It also lists any
known and resolved issues in this version of TotalAgility.

Reporting Tables

Describes the Dimension and Fact tables of the Kofax Reporting
data warehouse that store information related to Capture client
activities of TotalAgility.

Reporting Views

Describes the sample views provided with Kofax Reporting.

Tables for Analytics

Tenant Management System Help

Describes the TotalAgility tables and fields used by Kofax
Analytics for TotalAgility.

Describes how to create and manage tenants using the
TotalAgility On-Premise Multi-Tenant system.

Tenant Management System Installation
Guide

Provides instructions for installing the TotalAgility Tenant
Management System.

TotalAgility Apps Help

Includes a suite of applications that allows citizen developers
to configure the workflow and capture items with little to

no training. TotalAgility Apps encapsulates the following
applications.

* Business Data

* Quick Capture

* Quick Classification
* Quick RPA

* Quick Rules

* Quick Skins

* Quick Workflow
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Guide/Help

Description

Web Capture Control Help

Provides details for using a Web Capture control in creating
multi-page documents, creating a new document in a new
folder, deleting pages that have been incorrectly scanned, and
more; also, describes the buttons available in a Web Capture
control toolbar.

Workspace Help

Provides details for using TotalAgility to design business jobs
and cases, assign resources, create forms, integrate with
external applications, and more.

Other documentation

Capture Client

Provides help for using Capture activities in TotalAgility.

Devices Help

Provides details for managing devices connected to TotalAgility.

Export Connector for TotalAgility

Provides instructions on managing an Export Connector and
setting up an Export Connector for a document type.

KC/KTM Converter

Provides instructions on how to convert Kofax Capture and
Kofax Transformation Modules projects into the correct format
so that they can be used in TotalAgility.

Kofax .NET Restful Web Service API for
Device the Client

Provides documentation for the Kofax .NET Restful Web Service
API for the Device Client.

Kofax .NET Legacy API for the Device
Client

Provides documentation for the Kofax .NET Legacy API for the
Device Client.

Message Connector

Provides instructions on how to configure and use Kofax
Message Connector.

MFP Starter Pack Getting Started Guide

Provides instructions on how to use TotalAgility to import and
process the MFP Starter Pack.

MFP Administrator Guides

Describe how to prepare MFP devices to work with TotalAgility.

MFP Web Services Connector SDK
Developer's Guide

Provides an overview and instructions for developing inputs
with the MFP Web Services Connector Software Developer Kit
(SDK). Along with this guide, the SDK provides documentation
for the Web services.

Repository Browser

Provides instructions on how to use the Repository Browser to
view the extraction results for a set of folders and documents.

Search and Matching Server

Provides documentation of the Kofax Search and Matching
Server, which handles search requests from various Kofax
applications for large volumes of data located at a remote site.

Transformation Designer

Provides instructions on how to use Transformation Designer
to set up, store, and test projects that contain all the necessary
information for processing documents.

Transformation Designer Scripting

Provides an introduction to the WinWrap Basic Editor and an
overview of the available scripting events.

XDoc Browser

Provides help on using the XDoc Browser, a program that
provides direct access to the document representation that

is used by TotalAgility. With XDoc Browser, you can open and
display an XDoc along with any referenced images for testing,
demonstration, and debugging purposes.
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Offline documentation

If you require offline documentation, you can download it from the Kofax Fulfillment Site. For each
language, a separate documentation package is available to download as a compressed file, such as
TotalAgilityDocumentation_7.11.0_EN.zip for English or TotalAgilityDocumentation_7.11.0_FR.zip for
French.

The English and Japanese .zip files include both help and print folders. The print folder contains PDF
guides, such as the installation guide and administrator's guide. The .zip files for other languages
contain a limited set of localized files.

The following procedure describes accessing TotalAgility documentation offline for English.

1. From the Kofax Fulfillment Site, download the documentation.zip file for the applicable
language, such as English.

2. Extract the contents of the compressed documentation file to your local computer.

3. In the TotalAgility product installation files, inside the Agility.Server.Web\Help folder,
create a folder for the desired language. For example, for accessing TotalAgility documentation
offline for English, create the EN folder as follows:

O 1n 2 distributed environment, copy files on the Web server, and apply the Web.config
changes on the Application and Web servers.

Copy the contents from the folder | Paste the contents to the folder

Designer \\TotalAgilityInstall\Agility.Server.Web\Help
\TotalAgility designer\EN

Q The TotalAgility installer creates the TotalAgility_designer
and API folders inside the Help folder. You must manually
create other folders such as Workspace and TotalAgilityApps
and then copy the contents into the respective folders.

Devices \\TotalAgilityInstall\Agility.Server.Web\bin
\Administrative\Help\Devices\EN

DocumentConverter \\Kofax\Document Converter\web\en\WebHelp

ExportConnector \\TotalAgilityInstall\Agility.Server.Web\Help
\ExportConnector help\EN

KCKTM_Converter <%ProgramData%>\Kofax\Transformation\en US\help
\KCKTM_ Converter

MessageConnector \\Kofax\KIC-ED\MC\web\en\WebHelp

RepositoryBrowser \\TotalAgilityInstall\Agility.Server.Web\Help
\RepositoryBrowser\EN

SDK_Documentation \\TotalAgilityInstall\Agility.Server.Web\Help\API
\EN

TenantManagementSystem \\TotalAgilityInstall

\Agility.Server.Web.TenantManagement
\TenantManagement\Help\TenantManagementSystem\EN
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Copy the contents from the folder

Paste the contents to the folder

TotalAgilityApps

\\TotalAgilityInstall\Agility.Server.Web\Help
\TotalAgilityApps\EN

TransformationDesigner

<%$ProgramData%>\Kofax\Transformation\en US\help
\TransformationDesigner

WebCaptureControl \\TotalAgilityInstall\Agility.Server.Web\Help
\WebCaptureControl\EN

Workspace \\TotalAgilityInstall\Agility.Server.Web\Help
\Workspace\EN

XDocBrowser <%ProgramData%>\Kofax\Transformation\en US\help

\XDocBrowser

Activity folder within CaptureClient
Example: DocumentReviewActivity

\\TotalAgilityInstall\Agility.Server.Web\Forms
\Controls\Capture\Help\DocumentReviewActivity\EN

10
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4. Navigate to the installation folder.

For the help

Perform the following steps

+ TotalAgility Designer

* Devices

+ Transformation Designer
+ XDoc Browser

*« KC_KTM Converter

a. Open TotalAgility Web.config in a text editor from the
following location:

\\TotalAgilityInstall\Agility.Server.Web

b. Locate the <appSettings> section and remove http://
docshield.kofax.com/KTA from the key value:
<add key="OnlineHelpURL" value="http://
docshield.kofax.com/KTA"/>.

TotalAgility Export Connector

a. Open Agility.Server.ExportConnector.exe.config in a text
editor from the following location:

\\TotalAgilityInstall\Agility.Server.Web\bin

b. Locate the <appSettings> section and remove http://
docshield.Kofax.com/KTA from the key value:
<add key="OnlineHelpURL" value="http://
docshield.kofax.com/KTA"/>.

Alternatively, run the Configuration Utility

(available from the TotalAgility Product installation
files at \\TotalAgilityInstall\Utilities
\ConfigurationUtility) and remove the URL for
online help from the OnlinehelpURL setting.

0 For the Transformation Designer, XDoc Browser, and
KC_KTM Converter Help to work offline and make sure

that TotalAqility is actively connected to Transformation
Designer. To connect TotalAgility to Transformation
Designer, log in to Transformation Designer and click File >
Connections and provide the connection path.

TotalAgility Message Connector

a. Open configuration.xml in a text editor from the following
location:

\\Kofax\KIC-ED\MC\web

b. Locate the <OnlineHelp>1</OnlineHelp> section and
replace 1 with 0.

TotalAgility Document Converter

a. Open configuration.xml in a text editor from the following
location:

\\Kofax\Document Converter\web

b. Locate the <OnlineHelp>1</OnlineHelp> section and
replace 1 with 0.

5. Save and close the configuration file.

Clicking the Help icon will launch the help for the installed product.

1
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Training

Kofax offers both classroom and online training to help you make the most of your product. To
learn more about training courses and schedules, visit the Kofax Education Portal on the Kofax
website.

Getting help with Kofax products

The Kofax Knowledge Base repository contains articles that are updated on a regular basis to
keep you informed about Kofax products. We encourage you to use the Knowledge Base to obtain
answers to your product questions.

To access the Kofax Knowledge Base:

1. Go to the Kofax website home page and select Support.

2. When the Support page appears, select Customer Support > Knowledge Base.

© The Kofax Knowledge Base is optimized for use with Google Chrome, Mozilla Firefox or
Microsoft Edge.

The Kofax Knowledge Base provides:

Powerful search capabilities to help you quickly locate the information you need.
Type your search terms or phrase into the Search box, and then click the search icon.
Product information, configuration details, and documentation, including release news.

Scroll through the Kofax Knowledge Base home page to locate a product family. Then click the
product family name to view a list of related articles. Please note that some product families
require a valid Kofax Portal login to view related articles.

From the Knowledge Base home page, you can:

Access the Kofax Community (for all customers).
Click the Community link at the top of the page.
Access the Kofax Customer Portal (for eligible customers).

Click the Support link at the top of the page. When the Customer & Partner Portals Overview
appears, click Log in to the Customer Portal.

Access the Kofax Partner Portal (for eligible partners).

Click the Support link at the top of the page. When the Customer & Partner Portals Overview
appears, click Log in to the Partner Portal.

Access Kofax support commitments, lifecycle policies, electronic fulfillment details, and self-
service tools.

Go to the General Support section, click Support Details, and then select the appropriate tab.

12
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Chapter 1

Installation planning

TotalAgility is specifically designed to give organizations the flexibility to deploy either on-premise
or in the cloud. The TotalAgility Integration Server enables customers to utilize on-premise LOB
applications within TotalAgility Azure. You can configure various LOB Connectors within the
TotalAgility Designer, similar to TotalAgility On-Premise, and set the new nodes to execute either on
the Azure tenant or the Integration Server.

For information on supported operating systems and other system requirements, see the Kofax
TotalAgility Technical Specifications document on the Product Documentation site. The document
is updated regularly, and we recommend that you review it carefully to ensure success with your
TotalAgility product.

Review these important notes before you proceed with the installation.

+ For prerequisites, see the Kofax TotalAgility Prerequisites Guide available on the Kofax Fulfillment
Site.

+ If your solution includes multiple Kofax products, review the Technical Specifications document.

+ Obtain a license key for the Integration Server either from your Account Manager or from Kofax
Support.

+ Before extracting the TotalAgility installation .zip file, unblock the .zip file from the File Properties
window.

+ After installing the Integration Server, you can update the configuration settings by modifying
the configuration file or by running the configuration utility available from the installation files.
You must manually copy the utility onto the server where the configuration settings are to be
modified. See the Kofax TotalAgility Configuration Utility Guide.

Kofax Message Connector

Kofax Message Connector is a Windows service responsible for importing messages and files in
many electronic formats. It can retrieve documents using one of the following connection modes:

+ Storage mode: Retrieves documents from various sources and saves them in internal storage,
and they are available for retrieval using a web service interface. TotalAgility connects to the
Message Connector web service interface and retrieves the documents for import.

+ Direct Mode: Retrieves documents from various sources and directly imports them to TotalAgility.

Kofax Message Connector can import messages and files from many sources:
+ Email messages including attachments using various email protocols (SMTP, POP3, IMAP, EWS).

+ Fax messages (via internal fax over IP server or external fax servers: Kofax Communication
Server, RightFax, Biscom).

13
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* Files from a local or network folder.

For information on prerequisites for the Kofax Message Connector, see the Kofax TotalAgility
Prerequisites Guide and for information on deployment scenarios and advanced configurations, see
the Kofax TotalAgility Administrator's Guide.

System limits

The following system limits are applicable for 64-bit installations. For 32-bit installations, these limits
may vary.

* The maximum size of a message in Message Connector storage is 8 GB.
+ Up to three Message Connector instances on a single computer are allowed.
+ For KfxConverter, the maximum system memory usage limit is 4 GB.

O The limit of the input file size may vary, depending on the number of pages in a document,
type of document and type of conversion.

14
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TotalAgility Integration Server installation

This chapter describes two methods for installing the TotalAgility Integration Server:
+ Silent installation for multiple servers that use the same configuration.
+ Standard installation using the installation wizard.

Perform a silent installation
Use the silent installation to install the Integration Server without any user interaction. Once you
edit the silent installation file and run the command from a command line or a batch file, the
Integration Server installation proceeds automatically.

© The user who will run the Integration Server must have "Log on as Service" rights.

1. From your installation files, navigate to \\IntegrationServerInstall and open
SilentInstallConfig.xml using a text editor.

2. InSilentInstallConfig.xml, update the following parameters.

O Fix the line breaks if you copy and paste the code from this guide.

Parameter Default Value Description

PortNumber 3581 Keep default

SerialNumber empty (false) Keep default

ProductCode empty (false) Keep default

SkipLicense true Keep default

InstallDirectory C:\Program Files\Kofax Specify the Integration Server

\TotalAgility\ destination directory.

RunAsSystemAccount false If set to true, the IIS AppPool and
Kofax TotalAgility services run as the
LocalSystem account.

15
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Parameter

Default Value

Description

RunAsNetworkServiceAccount

false

If set to true, the IIS AppPool and
Kofax TotalAgility services run as
the NT Authority\Network Service
account.

0 Set

RunAsNetworkServiceAccount to
true only for Docker installations
that want to make use of a
Group Managed Service Account
(gMSA).

ValidOS

true

Set to true to check if the Operating
System is valid.

IISInstalled

true

Set to true to check if IIS is installed.

ImportSystemMaps

true

Keep default

InstallAction

IntegrationServerInstall

Accept the default.

InstallMode Silent Accept the default.

InstallType Both Select the install type. The Install
Type can be Application Server, Web
Server or both.

IsIntegrationServer false Set to true to install Integration

Server.

Tenantld

Provide a valid Tenant URL

Enter the valid Tenant URL.

0 When a Tenant is created, the
tenant URL is sent to the tenant
through email.

SystemSessionld

Provide valid System
Session Id

Enter the valid System Session ID.

ﬂ Log on to TotalAgility
Designer. On the Home page
click System Settings >
Settings. The System Session ID
is available on the General tab.

<SiteRoot>

Default Web Site

Install TotalAgility under a custom
site that uses a non-standard port
other than the standard ports (80
and 443).

For example, create a custom site
called "testsite" under IIS using port
number 85.

3. Ifinstalling TotalAgility on a non-standard port, modify the <TenantServiceURL>Provide
Valid Tenant URL</TenantServiceURL> parameter to include the non-standard port

number as follows:

16
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<TenantServiceURL>https://<tenantname.FQDN>:<non-standard port no></
TenantServiceURL>

4. Save and close the file.
On the Command Prompt, change the command line to the root directory of the Setup.exe file.
6. Run Setup.exe /Silent.

The following items are installed automatically:

+ Kofax TotalAgility Integration Server

+ Utility for Kofax Export Connector

+ Kofax Import Connector

b

The system generates a log file that reports errors (if any).
The success or failure of installation is indicated in the event log.

When automating installation, if you run setup.exe from Command line, or run setup.exe as a
silent installation, one of the codes returns to indicate the following:

* 0=Success
* 1-Success with warnings
« 2=Failure

Silent installation of the Transformation Designer

The Transformation Designer is typically installed as part of a full Kofax TotalAgility installation.
However, if you did not use the full installer or want to install Transformation Designer separately,
you can use the standalone Transformation Designer installer in silent mode. The installer is
available as part of the Kofax TotalAgility installation files.

1. From your installation files, navigate to \\TransformationDesigner and run one of the
following commands:

« If UAC (User Account Control) is enabled, right-click on the Command Prompt and select Run
as administrator.

+ If UAC is not enabled, run the Command Prompt.

The Command Prompt is displayed.

2. Run "TransformationDesigner Installer.exe" /quiet

The installer runs in the background.

You can use the same command to apply a fix pack over top of a compatible Transformation
Designer installation. Update the command name for the fix pack installer as needed.

Perform a standard installation

When you run the installation wizard, the following items are installed automatically:
+ Kofax TotalAgility Integration Server
+ Utility for Kofax Export Connector
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+ Kofax Import Connector

* You must have administrator account to install the Integration Server.
* The user who will run Integration Server must have "Log on as Service" rights.
* You can use hotkeys to navigate to next screen.

1. From your TotalAgility installation files, navigate to \\IntegrationServerInstall and run
one of the following commands:

+ If UAC (User Account Control) is enabled, right-click Setup.exe and select Run as
administrator.

+ If UACis not enabled, run Setup.exe.

The system starts the Kofax TotalAgility Integration Server installation.
O 1o exit the setup, click Cancel or press Esc.

2. Click Next.

3. In the Kofax Inc. Software License Agreement window, accept the terms in the License
Agreement and click Next.
The Type of Install window opens.

4. In the Type of Install window, choose Web/Application Server, and select instances for
Import Service .

You can now install multiple instances of the Message Connector. Select the check box for
Instance 2 and Instance 3 for Import Service. When you uninstall TotalAgility, all the instances
of Message Connector are also uninstalled.

Installs the Web and Application servers on a single machine.

5. Click Next.
The Software Checks window opens. The system displays a list of required software and
whether the software is installed.

6. Review the Detected Software list and proceed as follows:

+ If your system does not have all the required software, click Cancel to close the installer and
install the software.

+ If your system has all the required software, click Next.
The Destination window opens.
7. Use the default installation folder or click Browse to select a different path and click Next.
The Credentials window opens.
8. Enter the credentials for the user who will run Integration Server.

© This user must be an existing Integration Server user.
9. On the Root Website to host TotalAgility Application list, select the website to host the

Integration Server application. By default, the Default Web Site is selected. However, you can
select any other site as required.
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10.

1.

12.

13.

14.

© The websites added in IIS Manager appear on this list. To add a website in IIS Manager,
click start > Run > IIS Manager > Sites > Add Web Site.

To support SSL, select the Support SSL check box.

O the ssL option is only available if you have configured the https binding in IIS. See
Configure Kofax TotalAgility Integration Server for HTTPS communication.

Click Next.
Depending on the type of installation, the following window appears:
* When installing the Web/Application server, the Tenant Information window opens: Enter
the following information:
a. Tenant URL: The URL is available in the email sent upon tenant creation. Using this
URL, the system connects to the on-premise multi-tenancy tenant or Azure tenant.

Tenant URL examples: https://TenantName.<fullyqualifieddomainname>/
TotalAgility for on-premise multi-tenancy and https://
tenantname.cloudserviceURL/ for Azure.

b. System Session ID: This ID is used for Core Worker authentication with Kofax
TotalAgility in the Azure environment.

* When installing the Web Server, the Choose Server Location with Options window opens:
Choose the Integration Server mode as Multi Tenant or On Premise and enter the URL with
a fully qualified domain name and system session ID. Enter the Server name of your existing
Integration Server machine in the following format: HWw-ABC-w7 or provide the IP Address.

Click Next.
The Installation Review window opens and displays the settings.
Click Next.

The Installation Progress window opens. The setup installs the required files and other
integrated products.

Click Finish.
Your installation is now complete.

i B33 any errors occur during the installation, Integration Server creates a log file called
Kofax TotalAgilityInstallErrorLog.txt on your desktop. The log file is also created on the
desktop. Check this log file for error details. The success or failure of installation is indicated
in the event log.

After installing, further configure Integration Server to:
+ Integrate with Dynamics CRM.

+ Integrate with Dynamics AX.

+ Integrate with Micro Focus Content Manager.

+ Integrate with Kofax Communication Manager
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Standard installation of the Transformation Designer

The Transformation Designer is installed as part of a full Kofax TotalAgility installation. However,
if you did not use the full installer or want to install Transformation Designer separately, you can
use the standalone Transformation Designer installer that is available from the Kofax TotalAgility
installation files.

1. From your installation files, navigate to \\TotalAgilityInstall
\TransformationDesigner folder and run one of the following commands:

« If UAC (User Access Control) is enabled, right-click TransformationDesigner Installer.exe and
select Run as administrator.

+ If UAC is not enabled, run TransformationDesigner Installer.exe.

The system starts the installation.
© 10 exit the setup, click Cancel or Esc.

2. Inthe Transformation Designer Installation window, select the terms of the license agreement
and click Next.

The Install Options window is displayed.
3. Onthe Install Options page, select any additional settings and click Next.

The Installation Review window is displayed.
4. Click Install.

The Installation Progress window is displayed. The setup installs the required files.
5. Click Finish.

Your installation is now complete.

Perform TotalAgility installation in a Docker container

Overview

A Docker is an open platform for developing, shipping, and running applications. Docker enables
you to separate an application from its infrastructure. Using Docker, you can manage your
infrastructure in the same way you manage your applications.

Docker provides the ability to package and run an application such as TotalAgility in a loosely
isolated environment called a Container. The isolation and security allow you to run many
containers simultaneously on a given host using fewer resources than virtual machines.

You can deploy the TotalAgility application into your production environment, as an independent
container or orchestrated set of containers. This works the same whether your production
environment is a local data center, a cloud provider, or a hybrid of the two. You do not need to use
the TotalAgility installation program when TotalAgility is deployed in a Docker container. Instead,
TotalAgility is already installed and only the relevant configuration settings, such as database
connection strings, are required when the container runs.
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By default, all TotalAgility containers do not have limits for memory or CPU. SQL Server runs either
on another Windows container or another machine, but it does not run in the TotalAgility container.

Limitations

The following are the limitations that apply in a Docker environment:

+ Currently, Microsoft does not officially support MSDTC on Docker Windows containers. Therefore,
TotalAgility cannot have out-of-box support for split databases (main and archive). As a
workaround, enable Active Directory support for the containers by making use of Globally
Managed Service Accounts (GMSA). Once the container is in the same domain as the host
machine and SQL Server machine, MSDTC will be able to execute distributed transactions among
live and archive databases by resolving machine names using Active Directory.

+ Export Connectors are not supported in a container.

Prerequisites

We recommend using a standalone server for your database (not a container). Therefore, before
running TotalAgility inside a container, make sure the TotalAgility databases are set up and remotely
accessible (using either an IP address or a fully qualified domain name).

To use this setup, configure the following on the SQL Server being used:
* Firewall should allow remote access to SQL Server

+ Configure SQL Server to allow remote access with Mixed mode since the user is also allowed to
access without Windows Authentication.

+ Enable TCP/IP protocols for SQL Server.

© The "Named Pipes" protocol does not work.

Install Docker on the Windows server 2016 and higher

Set up Docker on your Windows server. This requires Windows Server 2016 or higher to support
running a TotalAgility Windows container.

i J Image Quality Analysis, Mobile ID, and Mobile Card Capture are not supported when you set
up Docker on Windows Server 2016.

1. Open an elevated PowerShell command prompt, and type the following commands:

Install-Module DockerMsftProvider -Force
Install-Package Docker -ProviderName DockerMsftProvider -Force

2. If areboot is required, restart your instance using the following command:
(Install-WindowsFeature Containers) .RestartNeeded

If the output of this command is Yes, restart the server using the following command:
Restart-Computer

3. Test your Docker Engine - Enterprise installation by running the "docker info" command.

docker info
Containers: 1
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Running: O

Paused: 0
Stopped: 1
Images: 26

Server Version: 18.09.3

Storage Driver: windowsfilter

Windows:

Execution Driver: <not supported>

Logging Driver: json-file

Plugins:

Volume: local

Network: ics 12bridge 1l2tunnel nat null overlay transparent

Kernel Version: 10.0 14393 (14393.2828.amd64fre.rsl release inmarket.190216-1457)
Operating System: Windows Server 2016 Standard Version 1607 (OS Build 14393.2828)
OSType: windows

Architecture: x86 64

CPUs: 4

Total Memory: 10.04 GiB

Name: HV-Docker-QA

ID: HI53:GJSY:3BWT:Z3S5:3NWU:DEFN:6D3X:KCX0:2EMJ: ITZR:QAVY : VXFK

Docker Root Dir: C:\ProgramData\docker

Debug Mode (client): false

Debug Mode (server): false
Registry: https://index.docker.io/v1l/
Labels:
Insecure Registries:
127.0.0.0/8

4. Optional. NLP support for Transformation Server within Docker is not enabled by default. To
make Docker work with NLP within the Transformation Server, and to increase the default
maximum size for the Docker container images, perform the following steps:

a. Open daemon.json available at “c:\ProgramData\docker\config”. If the file does not
exist at that location, create the file.

b. Append the following text to daemon.json:

{
"storage-opts": ["size=50GB"]
}

c. Restart the Docker Engine service.

Use Image Quality Analysis, Mobile ID, and Mobile Card Capture on
Docker

To use Image Quality Analysis, Mobile ID, and Mobile Card Capture in a container, Windows Server
2019 or higher must be used as a container host with the following Docker base container specified
in the Docker file, mcr.microsoft.com/dotnet/framework/aspnet for all the TotalAgility
container types (including RTTS and Transformation Server), where the "Image Quality Analysis,
Mobile ID, and Mobile Card Capture" are required.

Make the following changes in the Docker file:

+ Add the following line: RUN powershell "Set-ExecutionPolicy -ExecutionPolicy
RemoteSigned" before the line, RUN powershell C:\KTA\PowershellScripts
\ConfigureContainer.psl
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+ Additionally, Mobile ID and Mobile Card Capture have a prerequisite for the VC++ 2013 x86
redistributable. This can be automatically downloaded and installed in the Docker file.

+ Make sure that the following DLLs are present when you run Image Quality Analysis, Mobile
ID, and Mobile Card Capture applications (32-bit DLL dependency) on Windows Server 2016 or
2019. Copy the 32-bit version of DLLs (avicap32.dll, avifil32.dll, msacm32.dll, msvfw32.dll) from
the host's C: \Windows\SysWOw64 and paste the DLLs in the Docker container's C: \Windows
\SysWOW64 folder.You must copy these DLLs to all containers running the Transformation
Service.

Create a TotalAqility Docker container image

A container is defined by its image as well as any configuration options you provide when you
create or start it.

To create a Docker image, you need Internet connectivity because Docker uses the Microsoft
"microsoft/aspnet" image as a base onto which the prerequisites are installed (from the base
operating system or from the Internet when any feature is not available on the image).

Orora TotalAgility Docker container to be successfully built, approximately 100 GB of free disk
space is needed.

Integration Server

To create a TotalAgility Docker image on the Integration Server, perform the following steps.
1. Extract the contents of Kofax TotalAgility-7.11.0.ZIP to a <source directory>.
2. Create a new folder, <workingdirectory>.
Your Docker commands will be run from this directory.

3. Copy the contents of <source directory>\Utilities\Docker to <working directory>.

4. Move the contents of the <source directory> folderto <working directory>
\ContainerFiles.

The file structure should be as follows:

<working directory>\Dockerfile

<working directory>\ContainerFiles\ContentManagerInstallation
<working directory>\ContainerFiles\DAXInstallation

<working directory>\ContainerFiles\DynamicsCRMInstallation
<working directory>\ContainerFiles\IntegrationServerInstall
<working directory>\ContainerFiles\KIC

<working directory>\ContainerFiles\RepositoryBrowser

<working directory>\ContainerFiles\TransformationServer
<working directory>\ContainerFiles\Utilities

<working directory>\ContainerFiles\PowerShellScripts

5. Update the parameters as needed for each container type. See Silent installation configuration.
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6. To create the image, open a PowerShell window on the container host and run the following

command:

docker build -t <imagenamegoeshere> "<fullpathtoworkingdirectory>"

© container host is the machine where the Docker server is installed. Performance of a
build command depends on the number processors in the container host machine. The
command may take approximately one hour to complete with a quad core processor

configuration.

Example: The following command generates the image with the name "kofaxis" using the
contents inside C:\Docker\Kofax TotalAgility:

docker build -t kofaxis "C:\Docker\Kofax TotalAgility"

Silent installation configuration

Parameter ‘ Value Description
Identity Information
RunAsSystemAccount true The IIS AppPool and Kofax TotalAgility services run as the
LocalSystem account. This can also be used to run the
container as a Group Managed Service Account (gMSA).
RunAsNetworkServiceAccount false When set to true, the IIS AppPool and Kofax TotalAgility
services run as the NT Authority\Network Service
account. This can also be used to run the container as a
Group Managed Service Account (gMSA).
0 To run the container as a Group Managed
Service Account (gMSA), RunAsSystemAccount or
RunAsNetworkServiceAccount must be set to true.
Install Info
InstallType Both Set to <installation type for the container type>.
IsIntegrationServer true
ValidateTenant false Since it is expected that the user shall bring the
container up with valid configuration, validating the
tenant details is not needed.

Run a Docker container

A Docker container runs on any machine that supports the container's runtime environment.
Applications are not required to be tied to the host operating system, so both the application
environment and the underlying operating environment can be kept clean and minimal.

When a running container is stopped, any changes to its state that are not stored in persistent

storage disappear.

1. Open DockerSettings_IntegrationServer_Fulllnstall.Env available at Utilities\Docker

\ContainerFiles\PowershellScripts
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2. Do the following:

a. Replace all instances of “<localhostorISContainermachinename>" with the machine
name of the IS container you intend to create (value of -host-name in your "docker run"
command).

b. Replace all instances of “<tenantname>.<fgdn>" with the appropriate
“ktatenantname.machinename” (similar to the entry you make for accessing the OPMT
tenant in the hosts file).

3. Container access can be limited to the container host or can be port forwarded for global
access. Enable the required exposed port number in the firewall settings of host machine.

4. For non-Windows authentication:

a. The following command will bring a container up using the Kofax is image with the Kofax
TotalAgility settings applied from the DockerSettings_IntegrationServer_Fulllnstall.Env file
without windows authentication and forwarding the port 443 from the container into the
5000 port on the container host:

Example: The following command will bring a container up using the

kofaxis image with the Kofax TotalAgility settings applied from the
DockerSettings_IntegrationServer_Fulllnstall.Env file using Windows authentication with
the credentials specified in the win.json file.

docker run -d --hostname "opdemol" --name "opdemol" --env-file "C:
\Docker\TotalAgility\DockerSettings IntegrationServer FulllInstall.Env"
kofaxis

b. The following command will bring a container up using the Kofax is image with the Kofax
TotalAgility settings applied from DockerSettings_IntegrationServer_Fulllnstall.Env file
using windows authentication with the credentials specified in the win.json file.

Example: docker run -d --hostname "opdemol" --name "opdemol" --
security-opt "credentialspec=file://win.json" --env-file "C:\Docker
\TotalAgility\DockerSettings IntegrationServer FullInstall.Env"
kofaxis

5. Use"docker exec -it <container id\name goes here> powershell"to attachtoa
PowerShell session on the created container.

For example, the docker exec -it ispdemo3 powershell will bring up a powerhell session
inside the container with the "container's name" isdemo3.

Access TotalAgility Designer

After you connect to the Docker container and have verified that all services are in their expected
state, use the following URL to access the TotalAgility Designer outside the container host with the
port forwarded setup:

https://
<ipaddressofthecontainerhostgoeshere>:<exposedportofthecontainerhostgoeshere>/
TotalAgility/Designer

For containers hosting IIS - TotalAgilityWebsite:

When you configure the container for the Designer / Workspace, we recommend that you use a
VirtualHost file to configure the port and URI exposure through the host OS before you access the
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URL. You may also consider using a rewrite rule to ensure that any URL access is redirected to a

lowercase represe ntation.

As per RFC 2616, "...a client SHOULD use a case-sensitive octet-by-octet comparison of the entire
URIs...Comparisons of host names MUST be case-insensitive”.

The Docker daemon and cache hold case-sensitive resolutions of the URL and this can cause issues
if the casing of the URL is changed before first access. This caching issue occurs because of Docker's
use of WSL v1 and should be resolved in WSL v2. Within Docker, you cannot expose the same
container port for multiple protocols, and having previously cached a case-sensitive URL, the cache
must be cleared to replace it with the lowercase URL.

Additional information

This table includes some useful Docker commands.

Docker command

Purpose

docker images

Gets the list of all Docker images currently available on the
server.

docker ps -a

Gets a list of all containers available on the server.

docker start <containerID>

Starts the container with the ID <containerID> on the server.

docker stop <containerID>

docker rm <containerID>

Stops the container with the ID <containerID> on the server.

Deletes the container with the ID <containerID> on the server.

docker rmi <imagename>

Deletes the image with the ID <imagename> on the server, this
will be successful only if there are no child containers using this
image.

docker inspect -f "{{ .NetworkSettings.Net
works.nat.IPAddress }}" <containerID>

Gets the IP address of the container with the ID <containerID>.

docker cp "<containerID>:/<fullfilepathonc
ontainer>" "<pathtofolderonserver>"

Copies a file from the container to the server.

docker cp "<fullfilepathonserver>" "<contai
nerID>:/ <fullfilepathoncontainer>"

Copies a file from the server to the container.

docker logs <containerID>

To see all logs of a particular container.

docker logs - tail n <containerID>

To see the last "n" logs of a particular container.

type <FQDN of text file>

To view the content of text file within powershell instance.

Get-Process

To get the list of all processes.

Get-Service

To get the list of all services (running and stopped).

start-service ServiceNameGoesHere

To start a particular service.

Stop-service ServiceNameGoesHeres

To stop a particular service.

Get-WMIObject Win32_Service | select sta
rtname, name, status

To get the list of all services with some additional columns.

10 | format-table -auto -wrap

Get-EventLog -LogName Application -newest

To get the last 10 application logs from event viewer.
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Docker command Purpose
import-module webadministration To be run before the below commands.
get-iisapppool To get the name of the Application pool.

get-itemProperty -path IIS\APPPOOLS\Tot | To get identity information of the Application pool.
alAgilityAppPool -name

Use Integration Server with on-premise multi-tenant server
deployment

When installing the Integration Server with a separate Web-Application on-premise multi-tenant
server deployment, the Integration Server is required to point to the on-premise multi-tenant
Application server. This can cause an issue if the on-premise multi-tenant Application server is
not directly accessible by the Integration Server. To avoid this, we recommend that you point the
Integration Server to the on-premise multi-tenant Web server.

1. Navigate to the installation directory for the TotalAgility Integration Server.
2. Open Web.config in a text editor.
3. Locate the following section:

<appSettings>

<add key="CorelntegrationServicesLocation”" value="<on-premise multi-tenant
Web server machine name>;"/>
</appSettings>

4. Save and close the configuration file.

Encrypt and decrypt the configuration files

The Integration Server configuration files include the DB Connection settings and sensitive
information. Therefore, we recommend that you encrypt the following Integration Server files.

+ Web.config
+ Core Worker config
+ Export Worker config

Encrypt and decrypt web.config

The Integration Server, Web.config file is located under <kofax Install location>
\TotalAgility\Agility.Server.Web.

Use the Microsoft ASP.NET IIS Registration Tool (aspnet_regiis) to encrypt or decrypt any section of
the Web.config file. For more information, see http://msdn.microsoft.com/en-us/library/
zhhddkxy (v=vs.100) .aspx.

At a minimum, encrypt the appSettings section that includes the Database connection information.
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Encrypt and decrypt the Core Worker or Export Worker config

The Integration Server Core Worker config and Export Worker config files are located under
<Kofax Install location>\TotalAgility\CoreWorkerService

The TotalAgility Server supports two encryption methods:

* DPAPI encryption
* RSA encryption

Use the Kofax.CEBPM.Encryption.exe utility to encrypt and decrypt files with either of these
methods.

Use the Kofax.CEBPM.Encryption.exe utility

The Kofax.CEBPM.EncryptConfig.exe utility (located in the Integration Server installation directory)
encrypts (-enc) or decrypts (-dec) any section of a configuration file.

At a minimum, encrypt the appSettings section of each config file that includes the user ID and
password as well as other sensitive information. Use the optional -h flag to display help for the
command.

Kofax.CEBPM.EncryptConfig.exe cannot work with Web.config, it can only work with configuration
files or executables.

© Add the following security provider to the configuration file before encrypting the file:

<configProtectedData>
<providers>
<add useMachineProtection="true"
name="DPAPIProtection"
type="System.Configuration.DpapiProtectedConfigurationProvider,
System.Configuration, Version=2.0.0.0, Culture=neutral,
PublicKeyToken=b03f5f7f11d50a3a" />
<add name="RSAProvider"
type="System.Configuration.RsaProtectedConfigurationProvider,
System.Configuration, Version=2.0.0.0, Culture=neutral,
PublicKeyToken=b03f5f7f11d50a3a,
processorArchitecture=MSIL"
keyContainerName="CPUServerKeys"
useMachineContainer="true" />
</providers>
</configProtectedData>

Use the DPAPI encryption method

Because you must decrypt the file on the same machine where it was encrypted, use this utility to
encrypt one server at a time.

Run the utility on each TotalAgility Server individually.
1. Stop the Integration Server Core Worker Server service.

2. Navigate to the TotalAgility Integration Server Core Worker installation directory and open a
command-line window.
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3. Run the following command:

Kofax.CEBPM.EncryptConfig.exe -f Agility.Server.Core.WorkerService.exe.config -s
"appSettings" -p DPAPIProtection -enc

Use the RSA encryption method

RSA encryption is an algorithm for public key encryption and digital signatures that uses two
separate keys. Create a key and encrypt the configuration file on one Server, and export the key
to all the other Servers. All the TotalAgility Servers with the exported key installed can access the
configuration file. Use this method if you have several Servers with the same configuration.

The following instructions differentiate between the source TotalAgility Server where you create the
key and the target TotalAgility Servers onto which you import the key.

Prepare the key

Perform these steps on one source TotalAgility Integration Server,
1. Create the custom RSA key container:

a.
b.

C.

Logon to the Integration Server with administrator rights.
Open a command-line window.

Navigate to the .NET Framework version 2.0 directory. For example, enter the following
command:

cd \WINDOWS\Microsoft.Net\Framework\v2.0.*

. Run the following command:

aspnet_regiis -pc "<KeysFile>" -exp

where:

+ <KeysFile> is the name of the key file.

* The -exp option makes the key exportable.

2. Run the following command to grant the TotalAgility Integration Server Core Worker Server
service user permission to read the <KeysFile> RSA container file.

aspnet_regiis -pa "<KeysFile>" "<TotalAgilityserviceuser>"

where:

+ <KeysFile> is the name of the key file you created in step 1d.

+ <TotalAgilityserviceuser> is the Integration Server Core Worker Server service user.
3. Encrypt the file:

a.

b.

Log on to the TotalAgility Server as the TotalAgility Integration Server Core Worker Server
service user.

Navigate to the installation directory for the TotalAgility Server and open a command-line
window.
Run the following command:

Kofax.CEBPM.EncryptConfig.exe -f Agility.Server.Core.WorkerService.exe.config -s
"appSettings" -p RSAProvider -enc

This command encrypts the appSettings section of the configuration file. The appSettings
section includes the user ID and password as well as other sensitive information.
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4. Export the key by running the following command:
aspnet_regiis -px "<KeysFile>" "<c:\keys.xmI>" -pri

where:

+ <KeysFile> is the default keystore keyContainerName.

+ <c:\keys.xml> is the path and file name of the exported key file.

Import the key

Perform these steps on every target TotalAgility Server.
Import the key:

1.

a.
b.

e.

Log on to the TotalAgility Server with administrator rights.

Copy the keys.xml file from the source TotalAgility Server to the root C:\ directory of the
target TotalAgility Server.

Open a command-line window.

. Run the following command:

aspnet_regiis -pi "<KeysFile>" "c:\keys.xml"

where:

+ <KeysFile> is the default name of the key file.

+ <c:\keys.xml> is the path and file name to the imported key file.

Delete the keys.xml file on the target Server because it contains the unprotected private
key.

2. Run the following command to grant the TotalAgility Integration Server Core Worker Server
service user permissions to use the <KeysFile> RSA container file:

aspnet_regiis -pa "<KeysFile>" "TotalAgilityserviceuser”

where:

+ <KeysFile> is the name of the key file you imported in step 1.

+ <TotalAgilityserviceuser> is the TotalAgility Integration Server Core Worker Server service
user.

3. Repeat these steps on all remaining TotalAgility Servers.

Decrypt the configuration file

1.
2.
3.

Stop the Kofax TotalAgility Integration Server Core Worker Server service.
Navigate to the TotalAgility Server installation directory and open a command-line window.
Run the following command:

Kofax.CEBPM.EncryptConfig.exe -f Agility.Server.Core.WorkerService.exe.config -s
"appSettings" -p DPAPIProtection -dec

Repeat these steps to encrypt and decrypt the Export Worker configuration file.

Encrypt the configuration files in a docker container

To encrypt the Web.config files and all executable configuration files using "DPAPI", you must add
the following to your docker run command.
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-e KTA CONFIG ENCRYPTION PROVIDER TYPE="DPAPI"

For example, "docker run -d --hostname "opdemo2" --name "opdemo2" --
env-file "C: \Docker\TotalAgility\dockersettings.env" -p 5000:80 -e
KTA CONFIG ENCRYPTION PROVIDER TYPE="DPAPI" kofaxop"

To encrypt the Web.config files and all executable configuration files using "RSA", you must add the
following to your docker run command.

—-e KTA CONFIG_ENCRYPTION PROVIDER TYPE="RSA"

For example, "docker run -d --hostname "opdemo2" --name "opdemol2" --
env-file "C: \Docker\TotalAgility\dockersettings.env" -p 5000:80 -e
KTA CONFIG ENCRYPTION PROVIDER TYPE="RSA" kofaxop"

Edit the TotalAgility server configuration file

When you install TotalAgility, the system stores the configuration settings in a .NET file,
Agility.Server.Core.WorkerService.exe.config. To change the value of any parameter, edit the
configuration file or run the configuration utility. The Configuration Utility is available from the
installation files and must be manually copied to your Kofax TotalAgility server. See the Kofax
TotalAgility Configuration Utility Guide.

See

1. If you encrypted the configuration file after you installed the TotalAgility Server, decrypt the
file. See Decrypt the configuration file.

i B3 you used RSA encryption, decrypt the configuration file only on the source TotalAgility
Server where you initially encrypted the file.

2. Navigate to the installation directory for the TotalAgility Server.
Open the configuration file in a text editor.
4. Locate the following section:

w

<appSettings>
<add key="KeyNameString" value="which may contain passwords;"/>
</appSettings>

5. Edit the parameter values as needed.
Save and close the configuration file.

7. To re-encrypt the configuration file, run the encryption utility. See Encrypt and decrypt the
configuration files.

o

i B you used RSA encryption, export the key, and install the encryption key file on any
target TotalAgility Servers onto which you imported the original encrypted configuration file.

8. Restart the Kofax TotalAgility Integration Server Core Worker Server service.
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Add a thread pool monitoring interval

When long-running automatic activities are processed by the Core Worker, the threads in the
automatic activity thread pool are not freed up when the taken activity is reset due to timeout.
Configure a thread pool monitoring interval to free up the threads for these long-running taken
activities to allow other activities to progress once they time out.

You can configure the thread pool monitoring interval manually or use the Configuration Utility.

Manually

1. Navigate to the installation directory for the TotalAgility server.

2. In atext editor, open Agility.Server.Core.WorkerService.exe.config from the following
directory:

3. Locate the following section and add a thread pool monitoring interval (default:60).

<appSettings>
<add key="CoreWorkerThreadPoolMonitoringIntervalInSeconds" value="60"/>
</appSettings>

The default value is 60.
4. Save and close the configuration file.
5. Restart the TotalAgility Core Worker service.

Use the Configuration Utility

Run the Configuration utility and add the thread pool monitoring interval. See the TotalAgility
Configuration Utility Guide.

Anti-Cross Site Request Forgery (CSRF) measures

Use the following anti-CSRF measures to protect the site against Cross-site Request Forgery attacks.

+ Configure the Anti-CSRF tokens

+ Specify the Samesite attribute with value as Strict or Lax in the <hostCookies> tag of Web.config
to prevent CSRF attacks. See the Microsoft website for more information.

+ Enable Host prefix for cookies

Anti-Cross Site Request Forgery (CSRF) tokens

A CSRF attack relies on a user being authenticated on a website. The attack usually comes as

an email or website hyperlink on which the user clicks while still authenticated. This URL then
points back to the user's website and attempts to perform a privileged action (such as adding an
administrator account) without the user's knowledge. In TotalAgility, the TargetHostName and
TargetPortNo settings are added as Anti-CSRF tokens in the Web.config file. TargetHostName is
the fully qualified domain name of the web server and TargetPortNo is the website port number.
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When you provide these settings, the Anti-CSRF origin and referrer validations are performed on
the request URL. If the validation fails, the request will be terminated considering it a potentially
dangerous request.

You can configure the Anti-CSRF tokens in the Web.config manually or using the Configuration
Utility.

Manually

1. Navigate to the installation directory for the TotalAgility server.
2. In atext editor, open Web.config from the following directory:

3. Locate the following section and specify the target host name and target port number.

<appSettings>

<add key= “TargetHostName" value="<hostnamegoeshere"/>
<add key= “TargetPortNo” value="443"

</appSettings>

4. Save and close the configuration file.

Use the Configuration Utility

Run the Configuration utility and specify the TargetHostName and TargetPortNo settings. See the
Kofax TotalAgility Configuration Utility Guide.

Enable Host prefix for cookies

Use "Host Prefix for Cookies", a browser functionality that makes the cookies more secure by
prefixing the TotalAgility cookie names with "__HOST-". When a cookie name starts with this flag,

it triggers an additional browser policy on the cookie in supporting browsers. A Host--prefixed
cookie is only accessible by the same domain it is set on, which means a subdomain can no longer
overwrite the cookie value. It also makes a cookie accessible from HTTPS sites only. This protects
the cookie even if an attacker uses a forged insecure site to overwrite a secure cookie.

Edit the setting manually or use the Configuration Utility for enabling or disabling the cookies'
security.

Perform the following steps on the Web or combined Web/Application server.
1. From the Kofax TotalAgility installation files, navigate to \\TotalAgilityInstall
\Agility.Server.Web.
2. Open Web.config in a text editor.
3. Locate the <appSettings> section and make sure the value of "UseHostPrefixForCookies
value="true".

<appSettings>
<add key="UseHostPrefixForCookies" value="true"/>
</appSettings>

Use the Configuration Utility

Run the Configuration Utility and change the Host Prefix for Cookies setting on the Web settings tab

as needed.
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Exclude folders from the antivirus scan

In your antivirus application, add the following TotalAgility folders to the list of items that are
excluded from scanning:

* \\ProgramData\Kofax
* \\Program Files (x86)\Common Files\Kofax
* \\Program Files\Kofax\TotalAgility\
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Integrate Microsoft Dynamics CRM with
TotalAgility Integration Server

You can integrate Microsoft Dynamics CRM and Microsoft Dynamics 365 CRM with
TotalAgilityIntegration Server. To install both, the users must have administrator rights.

See also:
+ Dynamics CRM installation
+ Update the Web configuration file for Dynamics CRM

Install Dynamics CRM

Follow the same steps to install Dynamics CRM and Dynamic 365 CRM.

1. Navigate to \\DynamicsCRMInstall from your TotalAgility installation files, and double-click
Setup.exe.

For Dynamics 365 CRM, navigate to \\Dynamics365CRMInstallation from your installation
files, and double-click Dynamics365CRM Setup.exe.

The installation wizard appears.

Click Next.

In the CRM Server field, enter the IP address or machine name of the CRM server.
In the CRM Port field, enter the port on which CRM is running.

To enable SSL (Secure Sockets Layer), select Use SSL (default: Clear).

In the Domain field, enter the domain name.

Enter the Username and Password.

Click Finish.
The installation starts and registers the Event Handler in CRM and places necessary files in
Global Assembly Cache (GAC).

O NOWUVAEWN

Update Web.config for Dynamics CRM

Add the following script for the TotalAgility components to support event handlers in Dynamics CRM
and Dynamics 365 CRM:

i B you copy and paste the code from this guide, correct any incorrect line breaks.
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<configSections>

<section name="exceptionHandling"
type="Microsoft.Practices.Enterpriselibrary.
ExceptionHandling.Configuration.ExceptionHandlingSettings,
Microsoft.Practices.Enterpriselibrary.ExceptionHandling,
Version=5.0.505.0,

Culture=neutral,

PublicKeyToken=31bf3856ad364e35" requirePermission="true" />
<section name="loggingConfiguration"
type="Microsoft.Practices.Enterpriselibrary.Logging.Configuration.LoggingSettings,
Microsoft.Practices.Enterpriselibrary.Logging,
Version=5.0.505.0, Culture=neutral,
PublicKeyToken=31bf3856ad364e35" requirePermission="true" />
</configSections>

<loggingConfiguration

name:" "

tracingEnabled="true"

defaultCategory="General">

<listeners>

<add name="Event Log Listener"

type="Microsoft.Practices.Enterpriselibrary.Logging.TracelListeners.

FormattedEventLogTracelListener,

Microsoft.Practices.EnterpriselLibrary.Logging,

Version=5.0.505.0,

Culture=neutral,

PublicKeyToken=31bf3856ad364e35"

listenerDataType="Microsoft.Practices.Enterpriselibrary.Logging.
Configuration.FormattedEventLogTraceListenerData,

Microsoft.Practices.Enterpriselibrary.Logging,

Version=5.0.505.0,

Culture=neutral,

PublicKeyToken=31b£f3856ad364e35"

source="Total Agility" formatter="Text Formatter"

log="" machineName="." traceOutputOptions="None" />

</listeners>

<formatters>

<add type="Microsoft.Practices.Enterpriselibrary.Logging.Formatters.TextFormatter,

Microsoft.Practices.Enterpriselibrary.Logging,

Version=5.0.505.0,

Culture=neutral,

PublicKeyToken=31bf3856ad364e35"

template="Timestamp: {timestamp}{newline}&#xA;Message: {message}
{newline}&#xA;Category: {category}{newline}&#xA;Priority:
{priority}{newline}&#xA;EventId: {eventid}
{newline}&#xA;Severity: {severity}{newline}&#xA;Title:
{title}{newline}&#xA;Machine: {localMachine}
{newline}&#xA;App Domain: {localAppDomain}
{newline}&#xA;ProcessId: {localProcessId}
{newline} &#xA;Process Name: {localProcessName}
{newline}&#xA; Thread Name: {threadName}
{newline}&#xA;Win32 ThreadId: {win32ThreadId}
{newline}&#xA;Extended Properties:
{dictionary ({key} - {value}{newline}) }"

name="Text Formatter" />

</formatters>

<categorySources>

<add switchValue="All" name="General">

<listeners> <add name="Event Log Listener" />

</listeners>

</add>

</categorySources>

<specialSources>

<allEvents switchValue="All" name="All Events" />
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<notProcessed switchValue="All" name="Unprocessed Category" />
<errors switchValue="All" name="Logging Errors &amp; Warnings">
<listeners> <add name="Event Log Listener" />

</listeners>

</errors>

</specialSources>

</loggingConfiguration>

<exceptionHandling>

<exceptionPolicies>

<add name="Agility Exception Policy">

<exceptionTypes>

<add name="All Exceptions" type="System.Exception, mscorlib,

Version=4.0.0.0,

Culture=neutral,

PublicKeyToken=b77a5c561934e089"

postHandlingAction="NotifyRethrow">

<exceptionHandlers>

<add name="Logging Exception Handler"

type="Microsoft.Practices.Enterpriselibrary.ExceptionHandling.
Logging.LoggingExceptionHandler,

Microsoft.Practices.Enterpriselibrary.ExceptionHandling.Logging,

Version=5.0.505.0,

Culture=neutral,

PublicKeyToken=31b£f3856ad364e35"

logCategory="General" eventId="100" severity="Error"
title="Total Agility"

formatterType="Microsoft.Practices.EnterpriselLibrary.

ExceptionHandling.TextExceptionFormatter,

Microsoft.Practices.Enterpriselibrary.ExceptionHandling,

Version=5.0.505.0,

Culture=neutral,

PublicKeyToken=31b£f3856ad364e35"

priority="0" />

</exceptionHandlers>

</add>

</exceptionTypes>

</add>

</exceptionPolicies>

</exceptionHandling>

Update Web.config for the CRM virtual directory

<system.serviceModel>
<bindings>
<basicHttpBinding>
<binding name="BasicHttpBinding Service" openTimeout="00:10:00"
closeTimeout="00:10:00"
sendTimeout="00:10:00" receiveTimeout="00:10:00" allowCookies="true"
maxBufferSize="2147483647"
maxReceivedMessageSize="2147483647" maxBufferPoolSize="524288">
<readerQuotas maxDepth="2147483647" maxStringContentLength="2147483647"
maxArrayLength="2147483647" maxBytesPerRead="2147483647"
maxNameTableCharCount="2147483647" />
<security mode="TransportCredentialOnly">
<transport clientCredentialType="None" />
</security>
</binding>
</basicHttpBinding>
</bindings>
<client>
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<endpoint name="CorelntegrationEventServiceEndpoint"
binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding Service"

contract="Agility.Server.Core.Model.Interfaces.Services.IIntegrationEventService"

address="http://<TotaAgility server name or IP Address>/TotalAgility/Services/Core/
IntegrationEventService.svc"/>

</client>
</system.serviceModel>

(i ] Replace <TotalAgility server name or IP Address> with the IP Address of TotalAgility.
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Integrate Microsoft Dynamics AX with

TotalAgility

To install Dynamics AX,

+ Users created in TotalAgility must have Deployment Administrator rights.

+ If a user does not use the default Deployment Administrator to install the TotalAgility Dynamics AX
integration, the user must meet the following conditions:

+ Be the system administrator in AX.

« Have full CAL access.

Failure to meet the preceding criteria generates the following error message during installation:
"System unable to process request error."

1. Navigate to \\DynamicsAXInstall from your installation files and double-click Setup.exe.
The TotalAgility for Dynamics AX Setup wizard appears.

2. Click Next.

The window displays a list of prerequisite software for Dynamics AX.

O 1fthe required software is not installed, first install the software, and then install
Dynamics AX. If using Dynamics AX 2009, install .NETFramework 3.5. If using Dynamics AX
2012, install .NETFramework 4.0.

3. Click Next.

The Destination window appears.
4. Use the information in the following table to specify file paths in the Destination folder:

Destination Folder

Sample Path for Dynamics AX 2009

Sample Path for Dynamics AX 2012

DAX website Physical
Location

C:\inetpub\wwwroot
\MicrosoftDynamicsAXAif50\

C:\Program Files\Microsoft
Dynamics AX\60\AifWebServices

DAX website URL

Default Web Site/
MicrosoftDynamicsAXAif50/

Default Web Site/
MicrosoftDynamicsAXAif60/

DAX Client Physical
Location

C:\Program Files\Microsoft
Dynamics AX\50\Client\Bin\

C:\Program Files
(x86) \Microsoft Dynamics AX
\60\Client\Bin

DAX Server Physical
Location

C:\Program Files\Microsoft
Dynamics AX\50\Server
\DynamicsAx1\Bin

Not Applicable

5. Click Next.

The Credentials window appears.
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Enter your Username and Password to associate with the DAX Application pool.

Click Next.

The system displays the installation status and a summary of the installation report when the
installation is complete.

Click Finish.

i B3 you are using 64-bit operating system and Dynamics AX 2009 32-bit application, enable
the Application Pool account associated with the DAX Communicator site. In the IIS Manager,
click Application Pools > DAXAppPool > Advanced Settings and set True for Enable
32-Bit Applications.

Create Dynamics AX service reference to the TotalAgility web
service

As AOT (Application Object Tree) is in the Development Workspace, ensure to deploy the
Development Workspace to add in references. Otherwise, you cannot integrate TotalAgility with
Dynamics AX. See the following URL for instructions: http://msdn.microsoft.com/en-us/
library/gg846350.aspx.

Create Dynamics AX 09 service reference to the TotalAgility web service

1.

5.

Start Dynamics AX 09.

2. Click AOT (Application Object Tree) and press Ctrl+D.
3.
4. Complete the Add service reference window with the following information:

In the application object tree, Right-click References and select Add service reference.

a. WSDL URL: Enter the web URL of the DynamicsAxIntegrationService within the Agility IIS
web application, for example, http://Server/Agility.Server.Web/Services/SDK/
DynamicsAxIntegrationService.svc.

b. .NET code namespace: KtaEventsService.
c. Reference name: KtaEventsService.

d. Service description: Description of the service reference.
Click OK.

Create Dynamics AX 12 service reference to the TotalAgility web service

1.

Start Dynamics AX 12.

2. Click AOT (Application Object Tree) and press Ctrl+Shift+W.
3.
4. Browse to the TotalAgility assembly, KtaEvents.Services.dll which was installed previously. For

In the application object tree, right-click References and select Add Reference.

example,

C:\Program Files (x86)\Microsoft Dynamics AX\60\Client\Bin
Click OK.
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Add a reference in Dynamics AX

Add a reference to the Agility.Server.Integration.Common.dll assembly in Dynamics AX.

In Dynamics AX 09

1. Right-click References and select Add reference.
The assembly browsing form opens.

2. Browsetothe ...\client\bin directory of the Dynamics AX 09 installation. For example,
C:\Program Files (x86)\Microsoft Dynamics AX\50\Client\Bin)

3. Select the Agility.Server.Integration.Common.dll assembly and click OK.
The newly added assembly appears under references.

In Dynamics AX 12

1. Right-click References and select Add reference.

2. Browse to the TotalAgility assembly, Agility.Server.Integration.Common.dll, that was installed
previously. For example, C:\Program Files (x86)\Microsoft Dynamics AX\60\Client
\Bin.

The newly added assembly appears under references.

3. Click OK.

Edit the service configuration file for Dynamics AX 12
1. Browse to the client\bin directory of the Dynamics AX where the WCF service configurations
file, KtaEvents.Services.dll.config was copied by the installer.

2. Edit the endpoint to point to the valid TotalAgility Service for Dynamics AX notifications (...
Services/SDK/DynamicsAxIntegrationService.svc).

Import the TotalAgility connector class into Dynamics AX

1. Inthe AOT, click Import or press Ctrl+Shift+I.

2. Click Browse and navigate to the Dynamics AX Setup installation folder (in the Program
Files(x86) or Program Files directory). For example,

C:\Program Files\Dynamics AX Setup
3. Select the XPO class, such as Class_KtaController.xpo.
4. Click OK to initiate the import or compilation process.

O once the class is imported, the Status tab in the compiler output page displays any errors.
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Edit database X++ event methods

You can edit the database X++ event methods in the DAX Development Workspace under the
Classes and Application folders.

1.

To alter the Application CUD (create, update, and delete) class event methods, call the custom
class method EventChangeNotifyKtaWebService when a CUD event has been performed within
Dynamics AX.

Edit the Application class methods (InsertLog, DeleteLog & UpdatelLog) by adding a single
line to the appropriate location within each method:

+ Insertlog method: new
ktaController () .EventChangeNotifyKtaWebService ("Create", recordInserted,
null, conNull(), recordInserted.RecId);

+ Deletelog method: new
ktaController () .EventChangeNotifyKtaWebService ("Delete", recordDeleted,
null, conNull (), recordDeleted.RecId);

+ Updatelog method: new
ktaController () .EventChangeNotifyKtaWebService ("Update", recordOrig,
recordUpdated, changedFields, recordUpdated.RecId);

© The onsite AX Administrator registers the Databaselog events for various AX
documents. For example, if the Customer, Sales Order and Purchase Requisition documents
have the Insert, Update and Delete events registered against them, and when one of these
events execute for one of these documents, TotalAgility is informed through a WCF call.

Register the database log events

1.
. In the left-hand panel, expand the configure buttons » and select System Administration.

10.

Open Microsoft Dynamics AX 2012.

On the System Administration page, under Setup, click Database log setup. The Database log
window appears.

Click File> New. The Logging Database changes wizard appears where you can add and
remove tables and fields from the database log.

Click Next. Tables and Fields window appears.
Select the Show all tables radio button.

In the Tables and Fields window, under General Ledger, select Customers / Vendor Tables as
required and click Next.

Select the type of change (insert, update, delete, or rename) to register in the database log by
selecting the appropriate check box for the table.

Click Next. Logging Database changes window appears with the details of the selected tables
and fields.

Click Finish.
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Verify the Application Pool account

Verify that the Application pool account is using the correct Business Connecter.NET (BC.NET)
Windows credentials.

1.
2.

On the Start menu, select All Programs > Accessories and click Run.
Enter inetmgr and click OK.

The IIS Manager appears.

Navigate to Application Pool accounts.

Select the DAXKTA account and verify that the identity is the same as the BC.NET Windows
credentials.

If the credentials differ, do the following:
a. On the Actions panel, click Advanced Settings.

b. Select the identity and click Edit.
Click OK.
The Application Pool Identity window appears.
Click Set.
The Set Credentials window appears.

Enter the user credentials that are associated with the BC.NET account within Dynamics AX.

(The Kofax WCF service uses the BC.NET account to connect to Dynamics AX).
Click OK.
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Integrate Micro Focus Content Manager
with TotalAgility

This chapter provides the instructions for integrating Micro Focus Content Manager with TotalAgility

Integration Server.

Before installing the Content Manager server, install the following software:
« IIS

+ .NET Framework 4.6.1

+ TotalAgility (optional)

Identify the Content Manager SDK Version

These instructions only apply to the Content Manager version below 8.
1. Navigate to the C:\Program Files\Kofax\TotalAgility\ directory.

2. Right-click TrimSDKPIA20.dll and select Properties.
The TrimSDKPIA20.dIl properties window appears.

3. On the properties window, select the Version tab.
The File Version displays the current Content Manager version. For example, 7.3.0.

© ror TRIM SDK 7.3.0 and later, you will require to enter this number in the

<assemblyBinding> section of the Web.config (see Set up the Micro Focus Content Manager
server).

Set up the Micro Focus Content Manager server

To set up the Content Manager server, install and configure TotalAgilitytrimCommunicatorService
and then configure the event handler in the Content Manager system.

Install and configure TotalAgilityTrimCommunicatorService

To install and work with Micro Focus Content Manager with version 9.4 or higher, do the following.

1. Log on to the Content Manager server with an account with Local Administrator privileges.

2. Navigate to \\ContentManagerInstallation from the Content Manager installation files,
right-click on the executable Setup.exe, and select Run as administrator.
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The User Account Control window appears.
3. Click Yes.
The installation wizard appears.
4. Click Next.
The setup is ready to install the TotalAgility integration components.

If the Trim SDK already exists in your system, the Trim SDK Detected checkbox is by
selected by default. Click Finish.

This is applicable only for version Content Manager 9.4 or lower. From version 10, "Trim
SDK Detected" checkbox is not available.

If the Trim SDK does not exist in your system, the Trim SDK Detected checkbox is clear by
default and an error message appears. Also, the Finish button is not enabled. To resolve
this error, click Cancel and run Install CM_COMComponents_x64.msi from the Content
Manager installation files to get the Trim SDK. Rerun the Micro Focus Content Manager
server setup.

5. Configure the Web configuration file as follows:

a.

InC:\Program Files\Kofax\TotalAgility
\TotalAgilityTrimCommunicatorService, open the Web.config file in the text editor.

© For Micro Focus Content Manager with version 10 or higher, configure the
Web configuration file as follows: In C:\Program Files\Kofax\TotalAgility
\TotalAgilityCMCommunicatorService, open the Web.config file in the text editor.

Locate the configuration > runtime tag and edit the <assemblyBinding> section as
follows:

<assemblyBinding>

<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
<dependentAssembly>

<assemblyIdentity name="TrimSdkPIA20"
publicKeyToken="533fc65e30e543fa" />
<bindingRedirect oldVersion="6.2.2.8614"
newVersion="<latest version>" />
</dependentAssembly>

</assemblyBinding>

Replace the <latest version> with the version of TRIM SDK. See Integrate Content
Manager with TotalAgility.

Edit the <appsettings> as follows:

<appSettings>

<add key="TrimDocumentRecordType"
value="DocumentRecordType" />

<add key="TrimFolderRecordType"
value="FolderRecordType" />

<add key="WorkGroupServerName" value="ServerName" />
</appSettings>

+ Replace the DocumentRecordType with the value taken from the Content Manager
server by checking the record type of Document.
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* Replace the FolderRecordType with the value taken from the Content Manager server
by checking the record type of Folder.

* Replace the ServerName with the computer name of the Server.

To identify the computer name of the server, open Windows Explorer, right-click
Computer, and click Properties. In the Computer name, domain, and workgroup
settings group, click Change Settings. Copy the computer name.

© When you first install the TotalAgility Micro Focus Content Manager, a
TrimIntegrationAppPool with a local system identity is created. This causes an error

if the Content Manager server is remote. To resolve this error, you must update the
TrimIntegrationAppPool identity to account with Administrator permission. The
"TrimIntegrationAppPool" is referred as "CMIntegrationAppPool" from Content Manager
version 10 and higher.

Before uninstalling Micro Focus Content Manager installation components, make sure
you close the Content Manager application.

Configure the event handler in the Content Manager version

Configure TotalAgility events for actions in the Content Manager System.
1. Copy the following DLLs:

+ If using Content Manager version below 8, copy the following DLLs to the TRIM binaries
directory (usually C:\Program Files\Hewlett-Packard\HP Records Manager.)

+ Agility.Server.Integration.Trim.dll
+ Agility.Server.Integration.Model.dll
+ Agility.Server.Integration.Common

+ If using Content Manager version 8 and above, copy Agility.Server.Integration.Trim.dll to
the TRIM directory.

i ] Skip Step 1 and 2 for Content Manager 10 or higher.

2. For Content Manager to fire events in TotalAgility, register the
Agility.Server.Integration.Trim.dll file using RegAsm (regasm /codebase
Agility.Server.Integration.Trim.d11l).

3. To create the event handler in Content Manager 9.4 or lower, do the following:
a. Open Content Manager.

b. Select Tools > Context Administration > External Links.
The Content Manager Context External Links window appears.

c. Click New Record AddIn.
The Record AddIn Properties window appears.

d. Enter a Link Name.

e. Inthe COM Add-In PROGID field, enter the Progld,
Agility.Server.Integration.Trim.TrimIntegrationEventHandler.
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f. Select Add-In supports a multi-threaded environment.

g. Click OK.
The Content Manager Context External Links window displays the new link.

h. Select the link and click Properties.
The Record AddIn Properties window appears.

i. Click the Used By tab.

j. Check the Document and File Folder under the Record list and click OK.
This configures the Event handler on Content Manager.
4. To create an event handler in Content Manager 10 or higher, do the following:

a. Open Content Manager.
b. Select Context Administration > External Links.

c. Right-click in the window and select New External link.
The Select External Link Type pop-up appears.

d. Select the external link type as Generic add-in (.NET) and click OK.

The New External Link - Generic add-in (.NET) dialog box is displayed. By default, the
General tab is open.

e. Enter a Link name.
f. Enter the .NET Class Name as ContentManagerIntegrationEventHandler.

g. Under .NET Assembly Path, leave the defaults for Within special folder
and Folder or subfolder fields. For .NET Assembly Name, click @ and
browse to C:\Program Files\Micro Focus\Content Manager and select
Agility.Server.Integration.ContentManager.dll.

h. Select Add-In supports a multi-threaded environment.
i. Click the Usage (Record) tab.

j. Select the Document and File Folder options under the Record Type list and click OK.
This configures the Event handler on Content Manager 10 and higher.

5. In Windows Explorer, find the trim.exe.config file, open it in a text editor and add or replace
the following tags:

i B3 you cut and paste code from this guide, correct any incorrect line breaks.

<?xml version="1.0" encoding="utf-8" ?>

<configuration>

<configSections>

<section name="loggingConfiguration"
type="Microsoft.Practices.Enterpriselibrary.Logging.Configuration.LoggingSettings,

Microsoft.Practices.Enterpriselibrary.Logging, Version=5.0.505.0,
Culture=neutral, PublicKeyToken=31bf3856ad364e35" requirePermission="true" />
<section name="exceptionHandling"
type="Microsoft.Practices.Enterpriselibrary.ExceptionHandling.Configuration.
ExceptionHandlingSettings,
Microsoft.Practices.Enterpriselibrary.ExceptionHandling,
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Version=5.0.505.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"
requirePermission="true" />

</configSections>

<exceptionHandling>

<exceptionPolicies>

<add name="Agility Exception Policy">

<exceptionTypes>

<add name="All Exceptions" type="System.Exception, mscorlib, Version=4.0.0.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089"
postHandlingAction="NotifyRethrow">

<exceptionHandlers>

<add name="Logging Exception Handler" type=
"Microsoft.Practices.Enterpriselibrary.ExceptionHandling.Logging.
LoggingExceptionHandler,

Microsoft.Practices.Enterpriselibrary.ExceptionHandling.Logging,
Version=5.0.505.0,

Culture=neutral, PublicKeyToken=31b£f3856ad364e35" logCategory="General"
eventId="100" severity="Error" title="Total Agility"

formatterType=
"Microsoft.Practices.Enterpriselibrary.ExceptionHandling.TextExceptionFormatter,

Microsoft.Practices.Enterpriselibrary.ExceptionHandling, Version=5.0.505.0,
Culture=neutral, PublicKeyToken=31bf3856ad364e35" priority="0" />
</exceptionHandlers>

</add>

</exceptionTypes>

</add>

</exceptionPolicies>

</exceptionHandling>

<system.serviceModel>

<bindings>

<basicHttpBinding>

<binding name="BasicHttpBinding Service" openTimeout="00:10:00"
closeTimeout="00:10:00"

sendTimeout="00:10:00" receiveTimeout="00:10:00" allowCookies="true"
maxBufferSize="2147483647"

maxReceivedMessageSize="2147483647" maxBufferPoolSize="524288"> <readerQuotas
maxDepth="2147483647"

maxStringContentLength="2147483647" maxArrayLength="2147483647"
maxBytesPerRead="2147483647"

maxNameTableCharCount="2147483647" />

<security mode="TransportCredentialOnly">

<transport clientCredentialType="Windows" />

</security>

</binding>

</basicHttpBinding>

</bindings>

<client>

<endpoint name="CorelntegrationEventServiceEndpoint"

binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding Service"
contract="Agility.Server.Core.Model.Interfaces.Services.IIntegrationEventService"
address="http://<TotaAgility server name or IP Address>/TotalAgility/Services/
Core/IntegrationEventService.svc"/>

</client>

</system.serviceModel>

</configuration>

i ] Replace <TotalAgility server name or IP Address> with the IP Address of the TotalAgility
server.
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Integrate Kofax Communications Manager
with TotalAgility Integration Server

To integrate Kofax Communications Manager (KCM) server with TotalAgility Integration
server, manually replace the placeholder, {http://ccmserver:port} inthe following
format: http (s) : //<CCMServer>:<Portnum> in the Web.config file which is available in
Agility.ServerWeb.

See also:

+ KCM Proxy installation on the Web server

+ Update the KCM Server URL in TotalAgility Web.config
+ Install KCM Proxy manually

KCM Proxy installation on the Web server

This chapter describes three methods for installing the KCM Proxy Web server:
+ Silent installation

+ Standard installation

+ Docker installation

Ensure that the Microsoft plugin, Web Platform Installer is installed before installing the KCM Proxy
Web server. You can install the Microsoft Web Platform from the Microsoft website.

Silent installation

1. From your TotalAgility installation files, navigate to \\KCMProxyInstallation.

2. Launch a Command Prompt window and run Setup.exe and enter the KCM Server URL in the
following format: http (s) : //<CCMServer>:<Portnumber>.

Provide the IP address and port number of the KCM server. The installer updates the
Web.config with KCM server details and enables the proxy rewrite rules on the web server (IIS).

3. Press Enter.
The KCM Proxy is installed in silent mode.
The system generates a log file at the same location where Setup.exe exists.

Standard installation

1. From your TotalAgility installation files, navigate to \\KCMProxyInstallation and double-
click Setup.exe.
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The KCM Proxy Configuration window appears.

2. Enter the KCM Server URL in the following format: http(s) : //
<CCMServer>:<Portnumber>

The Web.config file is automatically updated with the KCM Server IP and the Port number.
3. Click Configure.
4. Click OK.

Docker installation

While generating the "dockersetting.env" file, if the URL is specified in the "KCM Server URL"
setting in the Configuration Utility tool, the same URL is used to install KCM Proxy and configure the
deployment in the container.

Update the KCM Server URL in TotalAgility Web.config

You can manually update the KCM Server URL in TotalAgility Web.config or run the Configuration
tool and update the settings before setting up the integration to KCM.

Manually update the KCM Server URL in TotalAgility Web.config

1. Navigate to the installation directory for the TotalAgility server.
2. In atext editor, open TotalAgility Web.config from the following directory:

3. Locate the following section:

<rewrite>
<rules>
<rule name="CCMInteractiveProxy" stopProcessing="true">
<match url="CCM/Proxy/Interactive/ (.*)" />
<action type="Rewrite" url="{http://ccmserver:port}/ccm/Interactive/
{R:1}" />
</rule>
<rule name="CCMDesignerProxy" stopProcessing="true">
<match url="CCM/Proxy/Repository/ (.*)" />
<action type="Rewrite" url="{http://ccmserver:port}/ccm/Repository/
{R:1}" />
</rule>
<rule name="ComposerUIJavascriptProxyRule" stopProcessing="true">
<match url="CCM/Proxy/ccmcomposerui.js" />
<action type="Rewrite" url="{http://ccmserver:port}/proxy/
ccmcomposerui.js" />
</rule>
<rule name="ComposerUICssProxyRule" stopProcessing="true">
<match url="CCM/Proxy/ccmcomposerui.css" />
<action type="Rewrite" url="{http://ccmserver:port}/proxy/
ccmcomposerui.css" />
</rule>
<rule name="ComposerUIImgProxyRule" stopProcessing="true">
<match url="CCM/Proxy/img/ (.*)" />
<action type="Rewrite" url="{http://ccmserver:port}/proxy/img/{R:1}" />
</rule>
<rule name="CCMDesignerStaticProxyRule" stopProcessing="true">
<match url="CCM/Proxy/static/ (.*)" />
<action type="Rewrite" url="{http://ccmserver:port}/ccm/static/
{R:1}" />
</rule>
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<rule name="ComposerUIFontProxyRule" stopProcessing="true">
<match url="CCM/Proxy/fonts/ (.*)" />

<action type="Rewrite" url="http://{ccmserver:port}/proxy/fonts/
{R:1}" />
</rule>
</rules>

4. Replace the http://<kcmserver>:<port> with the kemserver URL.
5. Save and close the configuration file.

Use the Configuration Utility

Run the Configuration Utility and update the configuration settings. See the Kofax TotalAgility
Configuration Utility Guide. (Navigate to Configuration settings >On-premise >App section).

Install KCM Proxy manually

You can install the KCM proxy without using the Web platform installer and KCM proxy installer.

1. Install IIS URL Rewrite 2.0.

2. Install Microsoft Application Request Routing 2.5 or higher for IIS.
3. Inthe IIS Manager, do the following:

On a server level, double-click the Application request routing cache.
Click Server Proxy Settings.

Select Enable Proxy.

2 n T o

Click Apply.
4. In TotalAgility Web.config, find {http://ccmserver:port} and replace it with http://

servername:port, Where servername is the host name of the KCM machine and port is the

port KCM listed as (default 8081). See the previous section for manually updating the KCM
Server URL in TotalAgility Web.config.

5. Uncomment the <rewrite> section.
6. Save and close the configuration file.
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Integrate Kofax SignDoc with TotalAgility

This chapter provides the instructions for integrating Kofax SignDoc with TotalAgility.

Set up the Kofax SignDoc server

Configure the Kofax SignDoc server to point to the relevant TotalAgility server to allow a callback
to occur when the signing is completed. The SignDoc server can be configured per the SignDoc
account to allow the same SignDoc server to call back to multiple TotalAgility servers.

Refer to the section on integration with TotalAgility in SignDoc documentation to know how to set
up the SignDoc server to point to the TotalAgility server.
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Configure TotalAgility Integration Server for
HTTPS communication

Enable SSL (Secure Sockets Layer) communication for the TotalAgility web layer and TotalAgility Core
Worker to communicate with core services and the Kofax Transformation Server.

To enable SSL for TotalAgility Application:

1.
2.
3.

4.

Open Internet Information Services (IIS) Manager.
Right-click the Default Web Site and click Edit Bindings.
Click Add.

a. Onthe Type list, select HTTPS.
b. On the SSL certificate list, select the certificate.

c. Click OK.
Click TotalAgility and click SSL settings on the Features tab.

a. Click Require SSL.
b. Accept the Client Certificates.
c. Click Apply.

Change the bindings in the Integration Server Web.config file

1.

usewnN

Open C:\Program Files\Kofax\TotalAgility\Agility.Server.Web\Web.config
file.

Uncomment the HTTPS SSL with application logon for all bindings.
Comment the HTTP with Windows authentication sections for all bindings.
Update httpGetEnabled="false" and httpsGetEnabled="true".

Save the file.

Update the Kofax TotalAgility Core Worker
Agility.Server.Core.WorkerService.exe.config locatedinthe C:\Program Files\Kofax
\TotalAgility\CoreWorkerService directory for all client endpoints BasicHttpsBinding_Service
and restart the TotalAgility CoreWorker service. The Kofax Transformation Designer can be updated
to use SDK SVC accessed through SSL, by updating the connection within Kofax Transformation
Designer options.
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Update Web.config

1.

Open Web.config located at your installed location. The default location is:
C:\Program Files\Kofax\TotalAgility\Agility.Server.Web
In <servicebehaviors>, the httpsGetEnabled setting is as follows:

<serviceBehaviors>

<behavior name="Agility.Server.Web.Services.Behavior">

<serviceMetadata httpGetEnabled="false" httpsGetEnabled="true" />
</serviceBehaviors>

By default, HTTPS mode is used with <security mode="Transport">. For the
BasicHttpBinding SharepointReceiverService, update the <security> setting as
follows:

If using HTTPS authentication, comment out the HTTP section:

<!-- HTTPS SSL with application authentication-->
<security mode="Transport">

<transport clientCredentialType="None"/>
</security>

0 For Windows or Manual authentication, the SharePoint Receiver Service must use
anonymous binding for HTTPS authentication.
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Launch TotalAgility Integration Server

1. Enter http://[TotalAgility server hostname or IP]/TotalAgility/Designer/
default.htm URL in the browser.

2. Enter the login credentials of the tenant used during installation.
TotalAgility Designer is launched in the browser.

3. Alternatively, click Start > All Programs > Kofax TotalAgility > Designer.
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Uninstall TotalAgility Integration Server

Uninstall using wizard

1. Click Start > All Programs > Kofax TotalAgility and select Uninstall or Repair Kofax
TotalAgility.
The Repair/Uninstall window opens.

2. Select Uninstall and click Next.
The Uninstall window opens.

3. Click Next.
The Uninstalling window opens.
When the uninstall is complete, the Uninstallation Complete window opens.
The summary report lists the components, servers, applications, and services uninstalled.

4. Click Finish.

O 1 there are any errors during uninstall, Integration Server automatically creates a log file
called Kofax TotalAgilityInstallationErrorLog.txt on your desktop. This log file contains
information on errors.

Uninstall in silent mode

1. Navigate to the root directory of the Setup.exe file.

2. Run Setup.exe /Silent/U.
The system uninstalls Integration Server and automatically creates a log file on your desktop.
This log file contains information on errors if any.

i ] Uninstalling in silent mode will not only remove the applied fix pack or service pack but

it will remove Kofax TotalAgility application completely. To install TotalAgility again, you must
install its base version and then apply any patches again.
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Uninstall Transformation Designer

If Kofax TotalAgility is installed on the same server as the Transformation Designer, it is removed
when Kofax TotalAgility is uninstalled. However, if you have a standalone installation of the
Transformation Designer you can remove the application with one of the following procedures.

Use the installation wizard

1.

Click Start > All Programs and right-click on the Transformation Designer.

A context menu is displayed.

Select Uninstall.

The Programs and Features window is displayed.

Click Kofax TotalAgility Transformation Designer 7.11.0 and select Uninstall.
The Installer window is displayed and the Uninstall option is selected.

In the Kofax TotalAgility Transformation Designer (7.11.0) Setup window, click Next.
Review the message and when ready, click Uninstall.

A progress message is displayed showing the status of the application removal.
When the uninstallation is complete, click Finish.

The Transformation Designer application is removed.

Use the silent mode
1. Navigate to \\TransformationDesigner from your TotalAgility installation files and run one

of the following commands:

+ If UAC (User Account Control) is enabled, right-click on the Command Prompt and select Run

as administrator.
+ If UAC is not enabled, run the Command Prompt.

The Command Prompt is displayed.

2. Run "TransformationDesigner Installer.exe" /quiet /uninstall.

An alternative command is "TransformationDesigner Installer.exe" /quiet /x.
The installer runs in the background to uninstall the Transformation Designer application.
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Upgrade process

Navigate to TotalAgility from your installation files and double-click Setup.exe and follow the
upgrade instructions.

If any errors occur during the upgrade, TotalAgility creates a log file called Kofax
TotalAgilityInstallErrorLog.txt on your desktop. Fix the errors.

On upgrading, the TotalAgility Integration Server installer restores the following configuration
settings:

+ All existing AppSettings

+ All existing Security Bindings

Upgrade TotalAgility Integration Server in silent mode

1. Go to the root directory of setup.exe.

2. Open the Command Prompt window as an Administrator and change the command line to the
root directory of Setup.exe.

3. Run Setup.exe /Silent /Upgrade.
The system generates a log file that reports errors (if any).
The success or failure of installation is indicated in the event log.
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Troubleshooting

This section describes the issues you may encounter and their resolution.

TotalAgility Integration Server AppPool exists

The Integration Server creates an application pool called TotalAgility AppPool. Ensure you do not
have an existing application pool of the same name as it may cause issues when installing or
upgrading.
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